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1.1 Pretium

PRETIUM
Personal Finances Software V1.01

by David Orr Copyright (C) 1997 IDD
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Contacting IDD

E-mail: idd@pobox.com
Phone: (352) 373-9471 Fax: (407) 331-3175
Mail: IDD, 204 NW 25th Street, Gainesville, FL 32607

1.2 Introduction

Welcome to Pretium! Pretium is a quality personal finances software
package designed for the Amiga. It is as simple to use as writing in your
checkbook, but advanced enough to take advantage of the power of your
Amiga.

To record a transaction (such as a deposit or withdrawal from your
checking account), simply enter the information the same way you would
record the transaction in your checkbook. Pretium keeps track of the
balance for you. If you want a clearer picture of where your money is
going, you can have it print a report at the click of a button.

It also handles more than just checking accounts. You can use Pretium
for keeping track of credit card charges and payments, savings accounts,
petty cash funds, cash transactions, and more. In fact, you can work with
many separate accounts on-screen at one time.

1.3 Requirements

Pretium requires AmigaDOS version 2.04 or better. It is hard drive
installable, but may be run from a single floppy. A printer is optional but
recommended.

1.4 Starting up Pretium

To run Pretium from Workbench, you only need to double-click the Pretium
icon. There are no tooltypes to bother with.

If starting it from a CLI shell, your current directory should have the
"AcntGrp." subdirectories in it. If you don’t start it from the correct
directory path, you will need to use the "Select Path" button when you open
an accounts group to change to the correct path. When starting Pretium
from a CLI shell, you may specify an accounts group to open by entering
"pretium" followed by the name of the accounts group (ITALICS(not)
including the "AcntGrp." prefix of the directory name). The group must be
located in the directory from which Pretium is loaded.

To quit the program, select "Quit" under the "Project" menu.
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1.5 Opening an Existing Accounts Group

You must first open an accounts group before you can perform operations
on any of the accounts in the group. To open an accounts group, select
"Open Group..." from the "Project" pull-down menu. This will bring up a
list box window that shows you a list of all accounts groups found in the
current directory path. (What it actually displays is all subdirectories of the
current directory starting with "AcntGrp." but without the "AcntGrp." part
of the name.) The current path is shown at the top of the window. The
default path is the directory you last used to load an accounts group, or the
directory from which the Pretium program was loaded. To change the
path, use the "Change Path..." button. This will bring up a file path
requester.

IMPORTANT NOTE: When using "Change Path..." you must select the
directory path to where the "AcntGrp." subdirectories are found, but do not
actually choose an "AcntGrp." directory with the path requester. Instead
go to the path where the "AcntGrp." directories are displayed in the
requester’s file list, and hit "OK" to return to the accounts groups window
to select an accounts group.

To open an accounts group in the list first click on it to select it, then click
the "Open" button at the bottom of the window. Or you can simply double-
click on an account to open it. Whenever you open an accounts group,
Pretium will also open any accounts that where open at the time the
accounts group was last saved.

You can open the included "SampleGroup" accounts group to see a sample
set of Pretium accounts.

When you first run Pretium, you may specify an accounts group to open by
entering "Pretium" followed by the name of the accounts group. The group
must be located in the directory from which Pretium is loaded.

1.6 Creating an Accounts Group

Accounts are stored in together in Account Groups. You will probably
never need more than one accounts group. All accounts in an accounts
group are located in one directory, and they share the same categories and
other information. Your accounts group might include a savings account,
a checking account, and an account for each of your credit cards.

To create a new accounts group, select "New Group..." from the "Project"
menu. This opens a requester that allows you to enter a name for the
group, as well as the path to where the accounts group subdirectory will be
located, and an optional password. "Path" shows the location where this
directory will be created (the default is the directory from which the
Pretium program was loaded). To change the path, click "Change Path..."
and a path requester will open.

If you enter a password in the "Password" field, you will be required to
enter it again whenever you open the accounts group. Leave the password
field blank for no password.
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TIP: Write down your password! If you forget the password and you can’t
get back into your accounts, you can contact IDD for assistance. TIP_

When you hit "OK," a directory with the name you entered will be created to
hold the accounts. You will see an accounts group window open and you
will be ready to create the first account for this accounts group. To close the
accounts group, you can just click the standard close-window gadget in the
upper left corner of the window.

IMPORTANT: You must always close the accounts group. If you reset or
turn off the computer without closing the current accounts group, vital
information may be lost.

1.7 Working with an Accounts Group

After you have added an account, the name of the account will appear in
the box on the accounts group window. If you add more accounts, they too
will be listed in the box in the accounts group window. You can select an
account simply by clicking on its name. When an account is selected it will
be highlighted white in the list and its name will appear in the text gadget
at the bottom of the window. You can rename an account simply by
modifying its name in the text gadget and hitting enter. You can also delete
an account by hitting "Remove" while the account is selected. A requester
will allow you to verify your intentions before an account is actually
renamed or deleted.

In the accounts group window, double-clicking an account will open that
account. If the account is already open, its window will be moved to the
front.

The close-window gadget at the upper left corner of the accounts group
window can be used to close the entire group of accounts. This is identical
to selecting "Close Group" from the "Project" pull-down menu. Closing the
group will close any open accounts. If an account has been modified, it will
ask if you want to save any changes before the account is closed.

IMPORTANT: You must always close the accounts group. If you reset or
turn off the computer without closing the current accounts group, vital
information may be lost.

1.8 Using the Pull-down Menus

If you see "Pretium Screen" on the title bar at the top of the screen it means
that no Pretium windows are currently active, and just need to click
anywhere on the Pretium screen to activate a window before you can use
Pretium’s pull-down menus.

The "Project" Menu

This menu has all of the standard Amiga project menu kinds of functions.
It starts with "Open Group," "New Group," and "Close Group." The
second section has three "Save All Modified" commands. Each of these will



in 5 / 13

save any accounts in the current accounts group that have been modified.

There are also "Program Settings," "About," and "Quit" options in the
Project menu.

The "View" Menu

The View menu is what you use to display special windows. The only
option currently available under this menu is "Categories," which displays
the categories list window for the current accounts group.

Window-specific Menus

A third pull-down menu will appear when certain windows are selected.
This third menu will appear ONLY when certain windows are selected,
and the menu’s functions apply only to that particular window (such as a
specific account). The name of the menu will be in brackets, such as "[This
Account]".

1.9 Using Requesters

Requesters in Pretium usually have an "OK" and a "Cancel" gadget at the
bottom. You will notice that in most of the requesters, the "OK" button
appears raised and the "Cancel" button appears recessed (pushed in). This
indicates that if you hit enter, the raised button will be selected, or if you hit
the escape key, the recessed button will be selected. This allows you to use
the keyboard instead of the mouse when it’s more convenient.

- Raised "OK" Buttons -- the ENTER key "clicks" it.
- Recessed "Cancel" Buttons -- the ESCAPE key "clicks" it.

TIP: The escape and enter keys will not function in this way while a string
gadget is selected. You can hit enter to deselect the current string gadget,
and then hit enter again or escape.

1.10 Using List Windows

The accounts group window is an example of a list box window. It uses the
same consistent interface as several other windows in Pretium, including
the account registers themselves. The general layout of the window is a
large list box, with a text gadget and several button gadgets below it. When
you click "New," the cursor will appear in the text gadget and you may
enter text (such as the name of a new account if you are in the accounts
group window). When you hit enter the new item will be created and after
it is created it will appear in the list box.

General information about list windows:

- Hitting the enter key while in the list window text gadgets is identical to
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clicking an OK gadget -- it tells Pretium that you want to submit the data
you entered.

- Use tab to move to the next text gadget (if there is one), and shift-tab to
move to the previous one.

- Hitting tab while the list window is activated but no text gadget is selected
will put the cursor in the first text gadget so you can begin entering data.

- To select an item in the list box, click on it once. The item will appear
highlighted and you can edit it by typing in data in the text gadgets at the
bottom of the window.

- Double-clicking on an item will have different results depending on what
type of window you are in. Double-clicking while in the Accounts List
window will open an account, while double-clicking on a transaction in an
account window will clear or unclear the transaction.

- "Reset" clears the text gadgets and de-selects any selected list items. It
does <b>not</b> clear the whole list. It only clears whatever changes you
might have been entering at the time for that particular item.

- "Remove" will delete the current item from the list (assuming you have
selected an item). Depending on what type of window you are in, it may ask
you if you are sure you want to delete it.

- There may also be "Open" or "Info..." buttons which will open the selected
item (such as an account from the accounts group window), or display
more information about the item.

- If you have selected an item, you will see the words "Modify" (such as
"Modify Account"). If no item is selected, you will see "Add" (such as "Add
Account"), which means it is ready for you to enter information for a new
item (which is the default mode).

1.11 Creating a New Account

To create a new account, go to the Accounts Group list window of the
accounts group you have opened, and hit tab or click on the text gadget at
the bottom. (You should see "Add a New Account", but if it says "Modify
Account" you need to click the "Reset" button first.) Now enter a name for
the new account and hit enter.

When you add a new account, a requester window will ask for the type of
account you wish to create (standard, checking, or credit). Here are
descriptions of the three types:

- Standard: Use for savings accounts, petty cash, and any other
type of account that allows you to deposit and withdrawal money. If you
want to use a check number or other identifying number for transactions,
use a Checking account instead.
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- Checking: This works just like a Standard account, but it has
a field for a check number in each column. The check number field may be
used for a special transaction number or any other code.

- Credit: This type of account works like a Standard account,
but it assumes the balance will usually be negative, so it displays positive
balances in red (instead of displaying negative balances in red). This is
because in a credit or loan type of account, you usually have a negative
balance that you eventually pay off until the balance is zero.

Below the account types is a field for a memo, which may be anything you
would like. The memo is included on all account reports you generate.
You can always change the memo later if you wish.

"Starting Check Number" is the starting check number that will be used for
Checking type accounts.

"Opening Balance" amount will determine how much money the account
will have for the first "Opening Balance" transaction which is
automatically added if the opening balance you enter is not zero.

You can also choose to set a password with the "Set Password..." button. If
you set a password, you will be asked to enter it again whenever you open
the account.

After you hit "CREATE" the account window will open.

1.12 Adding Transactions

The account register windows are where you will likely spend most of your
time when working with Pretium. They are used to enter and display all of
the transactions you make in your accounts. The account window is
always open when the account is open.

If you are using a screen mode with at least 16 colors, Pretium will display
standard accounts in green, checking accounts in blue, and credit accounts
in peach. The title of each account register window also says what type of
account it is, followed by the name of the account.

Account registers are list box windows, and function very similarly to the
accounts group window and all other list box windows in Pretium. To add
a new transaction, click on one of the text gadgets at the bottom of the
account window. There are several different fields where you may enter
information in a similar format to writing in a paper checkbook. The
names of the fields are shown at the top of the account window. You can
click on any one of the fields to enter text in it. You may also use the TAB
key to move to the next field, or SHIFT-TAB to move to the previous field.
Transactions are automatically sorted by date.

When you hit enter while editing a transaction, the transaction will be
added to the account and displayed in the list box. Note that after the
transaction is added, the cursor returns to the first text gadget. This makes
it easy for you to add many transactions, one right after another. To move
through a long list of accounts, use the scroll bar on the right side of the list
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box. You may also change the size of the account window using the resize
gadget on the bottom right corner.

The close window gadget on the upper left corner will close the account
window. If you have made any changes to the account, you will be asked if
you want to save changes before closing the account.

IMPORTANT NOTE: If you close an account window without saving it,
any changes you have made to the account will not be saved.

As with other list box windows, you can select a transaction to modify it by
clicking on it. You can also delete a selected transaction with "Remove". A
requester will open asking you to verify that you want to delete a
transaction, but you will not be asked to verify modifying a transaction.

Transactions in any type of account can be marked "cleared" by double-
clicking the transaction. A cleared transaction will have a small check
mark in the box between the two money fields of the transaction. The
cleared option is usually used to indicate that a check has been included in
your bank statement and therefore should be calculated as part of your bank
statement’s balance.

Below the list box you will see "Cleared" and "Total." These always show
the current balance of all accounts in the register. The "Cleared" amount
shows only the balance of transactions that have been marked with the
"cleared" check mark. "Total" is the total balance of all transactions in the
account.

There is also a running balance on the right side of each transaction. The
balance shown here is the balance of the account for all transactions up to
and including the current transaction. In bank and cash accounts
negative balances are shown in red, while positive balances are black. This
is reversed in credit accounts where negative balances are the norm and
are therefore shown in black, while positive balances are shown in red.

1.13 Account Transactions

Each transaction is made up of several different fields, which are arranged
to be similar to most checkbook registers.

The upper left field is the date, with the year directly below it. The year can
be any year from 1901 to 2099. When you add a new transaction the date is
automatically set to today’s date.

If the account is a bank account, the next field on the top is the check
number. If two transactions have the same date, the two transactions will
be put in ascending order according to their check number.

The "Description" field is the name you give to the transaction. Wildcards
("*", "?", or "#?") can be used in the description to copy over information
from a previous transaction.
The "?" wildcard will match any character. For example, "AB?D" could
match "ABCD," "ABDD," etc. The "*" will match any number of
characters. For example, "AB*D" would match "ABD," "ABCD,"
"AB123D," etc. The AmigaDOS style ("#?") wildcards can also be used.
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If you enter a wildcard in the description, then when you tab to the next
field, the other transactions in the account will be searched (starting from
the top) for a previous transaction with a description matching the pattern.
If a match is found, the pattern you entered will be replaced with the
matching description, and the previous transaction’s category and amount
will be copied over (unless a category or amount has already been entered
for the current transaction). This allows you to easily enter a new
transaction with the same information as a previous one.

The next two fields are where you enter the dollar amount of the
transaction. Normally only one of these fields is used at a time in a
transaction. The first is where you enter the amount if it is taking money
from the account, and the second is for adding money to the account. In
checking and standard accounts these fields are named "Withdrawal" and
"Deposit." And in credit accounts they are "Charge" and "Credit." If you
enter a value in both amount fields in a transaction, Pretium will subtract
the values in find the net amount.

TIP: Never use a dollar sign ("$"), comma (","), or other symbols other than
a cents separator (decimal point) when entering money values with
Pretium.

The "Category" field is used by Pretium to help classify and organize your
finances. Categories will be explained in detail in the "Using Categories"
section. If you add a transaction with a category that does not yet exist,
Pretium will ask if you want to add the category to the categories list. If you
choose "Yes," another requester will ask for more information about the
category. This requester will also be explained in the "Using Categories"
section. Categories are optional; the category field of transactions may be
left blank.

You may use "*" and "?" wildcards when you want to add a transaction
with the same category. These allow you to enter only part of a category
name, and Pretium will find the first category in the categories list that
matches your pattern. The pattern you enter will be replaced with the
category name after you hit enter to add the transaction.

The memo field allows you to enter any text you would like to add to the
transaction. This is a good place to record any details or information about
the transaction.

1.14 Using Categories

The "Category" field allows you to enter information that is not normally
included in paper checkbooks, but it gives Pretium the power to better
organize and evaluate your finances. Example categories you might use for
home finances include salary, food, clothing, gas, and rent. If you use
Pretium for business accounts, your categories might include
commissions, sales, freight, office supplies, and labor costs. You can also
create subcategories of your main categories for better organization.

All accounts in an accounts group share the same categories. A list box
window with a list of all categories can be opened by selecting "Categories"
from the "View" pull-down menu. As described in the "Account
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Transactions" section, categories can be added by entering a category that
does not yet exist when adding a transaction. New categories can also be
added directly at the categories window.

To add a new category, click on the text gadget at the bottom of the
categories window. After you enter a name and hit enter, a requester will
open for some additional information about the category.

At the top left corner of the requester are buttons that allow you to choose
either expense or income as the type of category. Choose "Expense" for
categories that generally deduct money from your accounts, such as food,
utilities, and mortgage payments. "Income" categories are for sources that
add money to your accounts, such as salary, bonuses, and gifts.

The type of account you choose is important because it will control how
Pretium calculates the balance associated with the category. The balance is
the net total of all transactions using the category. If you choose "Expense,"
transaction amounts that deduct money from your account are added to the
category’s balance, while transactions that add money to your account are
subtracted. Conversely, with an "Income" type category, transaction
amounts that add money from your account are added to the category’s
balance, while transactions that deduct money to your account are
subtracted.

The next gadgets in the requester will only appear if there are already other
categories in the list. They allow you to choose "Category" or
"Subcategory." Subcategories can be grouped under a category to show a
relationship so you can better organize your finances. If you choose the
"Subcategory" button, the box to the right of the buttons will list all of the
other categories. Choose the one that you want this category to be a
subcategory under by clicking on it. Note that subcategories can *not* have
their own subcategories ("sub-subcategories").

The next gadget is labeled "Memo." This allows you to enter a short
description or other information that you would like to associate with the
category.

The "Balance" line shows the current balance of all transactions using this
category. The default beginning balance is $0.00, but you may set any
beginning balance you want to use. You may also change the balance at
any time after the category is created. The balance is updated
automatically whenever you add or modify a transaction.

After you choose "OK," the new category will appear in the list.
Categories are listed in alphabetical order, with subcategories listed in
order under their parent categories. Subcategories are indented to
distinguish them from regular categories. Next to each category is its type
("Income" or "Expense") and the current balance of all transactions using
the category. The balance is updated automatically whenever you add or
modify a transaction. If a transaction uses a subcategory as its category,
the amount of the transaction is added to the balance of the subcategory and
the subcategory’s parent.

To rename a category, select the category and edit the name and hit enter.
To edit the category’s specifications, select the category and hit the "Info..."
button. Or you can just double-click on a category.
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1.15 Generating Reports

Reports can be generated based on a single account, multiple accounts in
an accounts group, or by categories. To generate a report for a single
account, click the little page icon in the upper right corner of the account’s
window (the icon is located just below the standard window depth gadget).
Or, you can also select the account window, then choose "Generate a
Report" from the "[This Account]" pull-down menu.

To generate a report based on multiple accounts, choose the report icon on
the Accounts Group menu, or use the Account Group window’s pull-down
menu. BOLD(Reports created from the accounts group window will be
based on only accounts that are currently open.)

To generate a categories report, choose the report icon on the Categories
window, or use the category window’s pull-down menu. Reports created
for categories will only contain transaction information from accounts that
are currently open.

Report Configuration Options

- Report Title Title placed at the top of the report.

- Detailed or Summary Report Detailed reports include each
individual transaction, while summary reports are just overviews of the
account or category. All of the other buttons are not used for summary
reports.

- Sort Parameter Transactions listed in the report can be sorted
by date, amount, or category. If the transactions are sorted by category, the
total balance is also calculated for each category. Category sorting is not an
option in category reports because category reports are already sorted by
category.

"Include Transactions Matching...Ó

- From Date/To Date Date range for transactions in the report.
Dates can be entered with month, day, and 2-digit year. If you do not enter
a year (month and day only), the year is assumed to be the current year.

- Cleared/Uncleared Use this to include only cleared
transactions, uncleared transactions, or both cleared and uncleared.

- Category Here you can enter a category to match transactions
with a specific category. Wildcards ("*", "?", or "#?") can be used to match
multiple categories. If you are generating a category report from the
categories list window, and a category was selected, the categoryÕs name
will appear here (which limits the report to that specific category).

"Include transactions Information...Ó

Here you can select which fields to include in the transactions listed in the
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report.

1.16 Quicken Interchange Format Files

NOTE: QIF importing/exporting is not included in the demo version.

The Quicken Interchange Format (QIF) is a text-based file format that is
used as a common standard by several commercial financial applications.
Data can be transferred between Quicken for Macintosh and Windows,
Pretium, and other finances software packages that have the QIF
importing/exporting feature. QIF files can also be used to copy transactions
from one account to another, even in a different accounts group or between
different types of accounts.

Exporting Data from Pretium

To export the data from an account in Pretium to a QIF file, first select the
window of the account. Then go to the "[This Account]" pull-down menu
and select "Export" under the "QIF" sub-menu. A file requester will open
that will allow you to choose the location and filename of the QIF file. When
you choose "OK," every transaction in the account will be saved to the QIF
file.

Importing Data to Pretium

To import transactions from a QIF file into an existing account, first select
the window of the account (or create a new account if you prefer). Then go
to the "[This Account]" pull-down menu and select "Import" under the
"QIF" sub-menu. A file requester will open that will allow you to choose the
QIF file to import. When you choose "OK," the transactions from the QIF
file will be added to the account.

Exporting Data from Quicken

In the register or write checks window of the account you want to export
from, choose "Export Transactions" from the "File" menu. Enter the range
of dates for transactions to be included in the exported file, and click "OK."
In the file dialog box, enter a name for the QIF file to be exported and click
"Save."

Importing Data into Quicken

In the register or write checks window of the account you want to import to,
choose "Import" from the "File" menu. In the file dialog box, choose the
QIF file to be imported and click "Open."

1.17 Troubleshooting

Hopefully you won’t have any problems using Pretium, but if you do please
first try to find an answer to your problem in this userÕs guide. If you still
need help, you can contact IDD through one of the following methods:
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E-mail: idd@pobox.com
Phone: (352) 373-9471
Fax: (407) 331-3175
Mail: IDD, 204 NW 25th Street, Gainesville, FL 32607

Note: If you get a "Program Error" or "Program Warning" message you
will notice a small code at the bottom of the requester in brackets ("[a562]"
for example). If you send us a message about an error or warning, please
include the special code in your message so that we will know where in the
program the problem occurred.
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